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How to Use This Course Book 
This handbook accompanies the taught sessions for the course. Each section 
contains a brief overview of a topic for your reference and then one or more 
exercises. 

The Exercises 

Exercises are arranged as follows: 

• A title and brief overview of the tasks to be carried out 

• A numbered set of tasks, together with a brief description of each 

• A numbered set of detailed steps that will achieve each task 
Some exercises, particularly those within the same section, assume that you have 
completed earlier exercises. Your lecturer will direct you to the location of files 
that are needed for the exercises. If you have any problems with the text or the 
exercises, please ask the lecturer or one of the demonstrators for help. 
This book includes plenty of exercise activities – more than can usually be 
completed during the hands-on sessions of the course. You should select some to 
try during the course, while the teacher and demonstrator(s) are around to guide 
you. Later, you may attend follow-up sessions at IT SERVICES called Computer8, 
where you can continue work on the exercises, with some support from IT 
teachers. Other exercises are for you to try on your own, as a reminder or an 
extension of the work done during the course. 

Writing Conventions 

A number of conventions are used to help you to be clear about what you need to 
do in each step of a task. 

• In general, the word press indicates you need to press a key on the 
keyboard. Click, choose or select refer to using the mouse and 
clicking on items on the screen (unless you have your own favourite 
way of operating screen features). 

• Names of keys on the keyboard, for example the Enter (or Return) 
key, are shown like this ENTER. 

• Multiple key names linked by a + (for example, CTRL+Z) indicate that 
the first key should be held down while the remaining keys are 
pressed; all keys can then be released together. 

• Words and commands typed in by the user are shown like this. 

• Labels and titles on the screen are shown l i k e  t h i s . 

• Drop-down menu options are indicated by the name of the options 
separated by a vertical bar, for example F i l e | P r i n t . In this example 
you need to select the option P r i n t  from the F i l e  menu. To do this, 
click with the mouse button on the F i l e  menu name; move the cursor 
to P r i n t ; when P r i n t  is highlighted, click the mouse button again. 

• A button to be clicked will look l i k e  t h i s . 

• The names of software packages are identified like this, and the 
names of files to be used l i k e  t h i s . 
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Software Used 

Audacity 2.0.3 
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Files Used 
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1 Introduction 
Welcome to the course A u d a c i t y :  E d i t i n g  S p o k e n  W o r d . 
This booklet accompanies the course delivered by IT Services, IT Learning 
Programme. Although the exercises are clearly explained so that you can work 
through them yourselves, you will find that it will help if you also attend the 
taught session where you can get advice from the lecturers, demonstrators and 
even each other! 
If at any time you are not clear about any aspect of the course, please make sure 
you ask your lecturer or demonstrator for some help. If you are away from the 
class, you can get help by email from your lecturer or from help@it.ox.ac.uk 

1.1 What You Should Already Know 
This session is one of a series that cover the important aspects of using Audacity 
to record spoken word (and other elements) that can then be used for podcasting 
or presentation aides. You will have confidence to build and manage audio files 
that can be used in a variety of ways and contribute to your personal media 
library. 
The computer network in IT SERVICES may differ slightly from that which you 
are used to in your College or Department; if you are confused by the differences, 
ask for help from the lecturer or demonstrators. 

1.2 What You Will Learn 
This course will help you learn to use Audacity to produce spoken word files. It is 
a single session, covering key techniques and automations, and provides tasks for 
hands-on practice. 
In this session we will cover the following topics: 

• Recording spoken word directly into the computer 

• Importing audio into the project from pre-recorded sources 

• Editing the audio to deal with problem areas 

• Improving the audio quality 
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1.3 Where Can I Get a Copy? 
You can download a copy of Audacity and all necessary and optional add-ons 
from: 
http://audacity.sourceforge.net/ 

 

Instructions on how to install the program and the LAME Mp3 encoder that is 
needed if you want to export audio as an Mp3 are found here: 
http://manual.audacityteam.org/o/man/faq_installation_and_plug_ins.html#H
ow_do_I_download_and_install_the_LAME_MP3_encoder.3F 
This software is open source and is free to use as well as being intellectually free 
to contribute to. It is also cross platform and will run happily on Linux, Windows 
and Apple operating systems. 
For more information on Open source projects and how they work, see: 
http://sourceforge.net 
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2 Audacity 
 
Show website 
Download and setup issues 
Record raw data 
Save and archive project 
Top and Tail – fade in 
Editing audio 
Splitting tracks 

The move tool 
Create new tracks 
Copy tracks 
Export selection as an audio file 
Import existing audio 
Audacity is a cross platform audio sequencer/editor that can record, import, edit 
and export audio in a variety of formats to suit a wide range of needs – including 
educational podcasting. The fact that it is widely used in higher education and is 
very capable in performance ensures its place as an essential tool in creating 
media for our Web 2.0 world Audacity is also one of the simpler audio editors to 
learn and is free to download from: 
Audacity 
http://audacity.sourceforge.net/ 

The website has comprehensive help sections and there are tutorials and the 
online manual under help. There is also a FAQ section and a wiki with some very 
useful entries about effects. Audacity allows many types of plugin effects that 
treat the sound recorded to be used. Effects in the formats of LADSPA, Nyquist, 
Audio Unit and VST are supported. The download page o the website begins to 
give an idea of the versatility and range of effects available. 
Use the manual to learn the program and follow the online links to follow areas of 
interest. 

 

Figure 1: The program's toolbar 

 

Figure 2: Project details in the bottom left of the program window 

You can use the project menu, import audio command to import mp3’s and wav 
files into Audacity for later editing. 
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3 Downloading and Installing Audacity and the 
LAME MP3 Encoder  

3.1 Downloading and installing Audacity:  
Downloading Audacity is very simple and the instructions for doing so on all the 
major platforms are here: 
http://manual.audacityteam.org/o/man/faq_installation_and_plug_ins.html#e
xe 
Here is the section covering Windows download and setup: 
Save: On the download page, left-click the "installer" link to save it to your 
computer. Check the browser preferences if necessary to find out where your 
downloads are saved. Alternatively, right-click over the link, "Save Target As" or 
"Save Link As" and choose the location to save the file to. Then double-click the 
downloaded .exe file to start the installer. You must be an administrator on the 
computer to do this, or follow the prompts to confirm your permission to install. 
Run: Using Internet Explorer and a few other browsers, you can left-click the 
"installer" link and select an option to "Run" the file. This launches the Audacity 
setup immediately. Note: Some security programs will query or block installers 
running from the computer's temporary space. 
Updating a previous installation: If you install a new Audacity version after 
installing a previous one, the installer will offer to install to the same directory as 
the previous installation. If the previous installation was Audacity 1.2 or 2.x, the 
installation directory is normally Program Files\Audacity (or Program 
Files(x86)\Audacity on 64-bit Windows). As long as you don't change the 
installation directory, Audacity will install over the previous 1.2 or 2.x version, 
and any extra plug-ins you added to the "Plug-Ins" folder will still be available. 
If the previous version was 1.3.x, please uninstall 1.3 before installing the current 
2.x version. After uninstalling 1.3, any extra plug-ins you added to that version 
will remain, and you can move them to the "Plug-Ins" folder of the new 
installation. 
Updating optional libraries: If upgrading from Audacity 1.3.6 or earlier, you 
must update to the latest LAME MP3 encoding library. Otherwise there is no 
need to upgrade LAME or FFmpeg unless this is indicated in the Release Notes 
for the new version of Audacity.Installing the MP3 Encoder 
Please look at for the full instructions and FAQ: 
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3.2 Setting Preferences 

 

Figure 3: The preference window for Audacity 

Setting up Audacity on your home machines should be easy – just select 
Preferences from either the Edit menu(Windows) or From the Audacity Menu 
(Mac) and point the program to the audio connecters and settings you wish to 
use. In the audio I/O tab, your sound card should be seen straight away and you 
can set it to be the input and output. USB mics and similar equipment should also 
be detected by Audacity and these should be selected as appropriate. 
The File formats tab deals with the Mp3 encoder and all you have to do is point 
Audacity to the place you downloaded (and uncompressed) the Lame encoder to. 
These task only have to be performed once and then you are ready to record and 
export as Mp3 whenever you need to. 
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4 Recording and Editing 

4.1 Recording 
Before recording you can check that your signal (your voice for example) is being 
seen by Audacity by choosing to monitor the input. You will see a red signal in the 
stereo meter above the drop down arrow if signal is being successfully monitored. 

 

Figure 4: The Monitor Input dialog – select to see the signal level of 
recorded source 

To record a track, press the red record button, and start to speak. When you want 
to stop recording you can press the space bar to stop. A new track will have been 
created and you should see a visual representation of the recorded sound waves 
running from left to right across the arrange area. 
There is a time ruler underneath the toolbar which is context sensitive; the time 
measurements change depending on how material has been recorded. 

 

Figure 5: A recorded track with the wave representation showing 

4.2 Saving your work 
Once you have recorded your raw audio you should save your project and archive 
the audio before doing any editing. This means you can always return to the 
original state of the project should you need to in future and saving the project 
regularly means that you will keep edits you are making safe from any program 
crashes 
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Choose File, save project to save your work as an Audacity project. You will be 
warded that you are saving in a special audio format that is unlikely to be opened 
by other programs like audio players. 

 

Figure 6: The file warning message that is shown when you save the 
project. Click ok 

This underlines the important difference between saving the project and 
exporting out the audio in a usable file type – these are different processes and 
are done for different reasons. You save the project so you can open it again in 
future and continue to work on it. You export the audio out in a file format that 
can be played by many devices so you can put your audio somewhere where it will 
be accessed by your audience – your website or a social media site for example. 

 

Figure 7: The track information pane. Select Audio Track to rename 

Name tracks by using drop down arrow in the track view. Call the first track 
original, the second, edit. 
Select View, fit in window to se the whole audio track. You can change the 
resolution of your view using the zoom tools and click and drag at the track edges. 
You can also choose fit vertically to fill the window with the two tracks. 

 

Figure 8: Audacity zoom tools 

You may want to record several piece of audio in the same project. If you press 
record again, a new track will be created automatically. The audio will start 
recording at the beginning of the project which might not be what you want. 
However, if you place the time line in the project where you want in the existing 
track, the new track will record from that location. This will allow you to record 
sections starting where you want. You can further edit tracks to fine tune them 
but the basic structure will be correct. If you record where other material is 
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already present on other tracks, you will want to mute these tracks. Click on the 
Mute button in the track header. 

 

Figure 9: Recording from a set place in the time line 
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4.3 Normalising a weak audio track 
Click in the track detail pane to select the entire track. Choose Effects, Normalize. 
This will increase the volume of the entire audio file proportionately, so that the 
signal peaks at – 3db (or the default setting). This leaves a little headroom for 
further processing. This is a quick and efficient way of boosting a weak audio 
recording’s signal to a useable level. One downside to using this tool is that it will 
of course boost any background noise as well. Another thing to consider is that if 
there is one loud moment in the track – a cough for example, then normalising 
the track will only increase the volume marginally. The cough will limit the effect 
as it is already loud. It is better to do a little editing before normalising – 
removing unwanted material and treating anything else that is too loud (see 5.6) 
so the whole track is reasonably uniform before choosing to normalise. Unless 
there is a good reason to do otherwise, normalising a track would be one of the 
last functions to perform. Some of the export choice include normalise too. 

 

Figure 10: Choosing the Normalize option from the effects menu 
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5 Editing 

5.1 Selecting material to edit 
When you edit material you first have to select it. Click and drag your mouse over 
the audio material in a track to select it. The audio will appear with a darker grey 
background. 

 

Figure 11: A selected piece of audio in a track 

5.2 Trimming the beginning and end 
Deleting silence at the beginning of the file. Click and drag to select the beginning 
section of the track where there is no wanted signal and then click backspace to 
delete it. You can select and delete material from anywhere in the track by doing 
this including the end. 

5.3 Fade in (and out) 
Select a short segment of file from the beginning of the file and then choose 
Effects, Fade In. This is very useful to avoid a surprisingly loud signal from the 
start. It allows the listener time to adjust to what they will be hearing. 

5.4 Cut, Copy and Paste 
You can cut or copy material and paste to other tracks or other parts of the same 
track: To select the part you wish to cut, copy or paste to, use the selection tool. 

 

Figure 12: Part of a track is selected ready for cut, copy and paste 
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Press and hold the left mouse button while you drag the mouse to mark an area. 
This area is now darker than the surrounding area of the clip. You can press the 
space bar to listen to the audio in the marked area to audition it to make sure you 
are happy with the selection.  
You can extend or contract your selection by holding down the SHIFT button and 
clicking on the area you wish your selection to extend or contract to. If you click 
at a spot that is on the left hand side from the middle of the current selection, you 
will set the right hand boundary of your new selection. 

5.5 Cutting the selection 
Cut the selection by selecting "Cut" from the Edit menu ...  or press CTRL+X. 
To undo this operation, select Undo in the Edit menu or press CTRL+Z. Copy 
(CTRL+C) will copy the selection to the clipboard. You can then paste that data 
back in to a new track (or at the end of an existing track) by selecting Paste in the 
Edit menu, or press CTRL+V (replace CTRL with CMD for a mac). 
During all operations of this kind, the bottom info pane of the screen will display 
the start time and the end time of your selection.  

5.6 Splitting, Copy and Move 
You can split audio into shorter segments to edit by using the Split command in 
the Edit menu. Make a selection and then choose Split and the Audio will be split 
into segments with their start and end points at the beginning and end of the 
selection you made. 

 

Figure 13: The Split option in the Edit menu 

Use the timeshift tool to move the audio around including putting onto other 
tracks. You can copy and paste audio by making a selection and choosing Edit, 
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Copy and pasting at another point in the time line and on another track if you 
wish. 

 

Figure 14: The white vertical lines indicate where the audio has been 
split 

 

5.7 Treating unwanted or difficult material 

5.7.1 The Amplify tool 
Use the selection tool and click and drag in the track over material that is 
unwanted or difficult to select it. It appears as a greyed area. If you click on Back 
Space you can delete that part of the file where the selected material was. 
You can also try to improve the audio selected by reducing the volume of problem 
areas such as plosives or sibilance. Choose Effects, Amplify. Select a reduction on 
the material. This can be can be more natural than deleting. Try setting the level 
up to -7 db to start with. You can re-apply the effect if needs be. If the problem 
sound is a pop or something similar, you can try the drawing tool to draw in a 
reduction where the lick plays. See the Tools Section to read about the Draw tool. 

 

Figure 15: The Amplify interface in Audacity can be used to reduce the 
volume of material 

5.7.2 Generating Silence 
Click on Generate, Silence. The selected area contains silence. The material has 
been erased and silence replaces it. This tool is obviously useful to remove 
background noise at beginnings and ends of recordings and unwanted audio 
anywhere within an audio file. Using the amplify tool to reduce volume often 
gives better (natural) results though. 
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Use the selection tool to click and drag the areas that contain silence. Press the 
backspace key to delete these from the audio file. You can use Edit menu, undo, to 
correct any mistakes you make. 
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6 Tools 

 

Figure 16: The Audacity tools with the selection tool in use 

6.1 Selection 
The selection tool is the default tool that your mouse operates when you start 
Audacity. You can use it to click and drag to select parts of different audio. You 
can select Audio from two or more different tracks if you drag across them. Play 
back will start from the point in the track you have selected using the selection 
tool. A black line across the track visually shows this. 

 

Figure 17: Two pieces of audio selected using the selector tool 

6.2 Envelope 
The envelope tool allows you to draw the volume changes such as fade ins and 
outs diretly to the audio. Click to create nodes and drag existing nodes in the 
track to change volume settings. Click anywhere in the track to create new nodes. 
Edit undo will help you experiment and get out of trouble if you make a mistake. 

 

Figure 18: Using the envelope tool 
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6.3 Draw 
You can draw in to the actual waveforms using this tool. Firstly you must zoom in 
to the waveform until you can see the individual nodes in the line. This will take 
multiple clicks on a zoom tool. Just keep clicking until you see the wave display 
change to having a series of dots. This can be useful to eliminate small pops and 
clicks from material.  ALT + click smoothes an area of audio  CTRL + click & 
hold edits only one sample, no matter whether you move the mouse left or right. 

 

Figure 19: A piece of Audio zoomed in to show the nodes 

6.4 Zoom 
Use the zoom tool to click into and area to expand its horizontal detail. If you 
click and drag to select a piece of audio with the zoom tool, that selection will 
then fill the width of he screen. Right click to zoom out. 

6.5 Time Shift 
The time shift tool allows you to move audio regions (not selections) backwards 
and forwards in the time line. Select this tool and click and drag the audio where 
you want it. This is specially useful if you have a multi track project that you edit 
and then need to line up the audio again so that it flows. Be careful to switch back 
to the selection tool afterwards. 

6.6 Multi Tool 
The multi tool allows you to perform the tasks of the selector tool and the 
envelope tool with one tool. 
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7 Other Track Types 

7.1 The Label Track 
Inserting a label track into your project means that you can add a label in the time 
line of the recording and then use it as a way of navigating the project, either 
visually or by jumping from one label to another. In longer projects, this is a very 
useful tool and can be deployed to signify content changes (sections of a long talk) 
or changes of the material (one recording finishes and another piece starts). 
Musically it can be used to annotate verses and chorus etc. 
In the project Select the Project menu and choose New Label Track: 

 

Figure 20: A New Label Track can be selected from the project menu 

 
 

 

Figure 21: Labels appear in red with a flag. Click on a label to edit its 
text 

 
You can insert a label anywhere along the time line by clicking with the selection 
tool in the audio file that you are referencing with the labels and then choosing 
Ctrl+B. A label will appear in the label track and you can enter text into it. You 
can run multiple label tracks in a project and export labels out to a a text file 
which can then be imported with annotations if there is a lot of text to be entered. 
Labels can be deleted by selecting them and choosing Edit menu, delete. To  
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7.2 Time Tracks 
Inserting a time track into your project gives you control over the play back speed 
of the recording. Essentially, you can speed up and slow down how the recording 
plays to accentuate detail. In a spoken word environment, this will not always be 
useful, but if you are adding commentary to field recordings, you may wish to use 
this tool to focus attention on sections. Click on the Project menu and choose New 
Time Track to create the track. Before you manipulate the time click on the track 
header pop down list and choose Set Range 
 

 

Figure 22: A time track before parameters have been changed 

Once you have a time track in the project, choose the set range option from the 
track header (see below) to set the maximum parameters fo change for the 
speeded up sections and the slowed down sections. It is in percentage values so 
200% as a range will allow you to double the speed of a section or halve it, 
depending on which paramerter you are setting. 

 

Figure 23: Click on the Track header drop down arrow to set the rnge 
of the time track 

 

Figure 24: Use the envelope tool to changes the time track 

Once you have selected the ranges you can use the envelope tool to create nodes 
in the time line that can be positioned to speed the track play up or slow it down. 
Just click above or below (above is faster) the horizontal line to affect the track. 
You can click and hold on a node to move it once it has been placed in the time 
line. 
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Figure 25: A time track with changes made - note the time ruler and 
the time indication in the track and how they change 
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8 Processing Audio 

8.1 Compression 
Simply put, a compressor reduces audio levels once they go over a set threshold. 
The compression ratio is the amount of reduction applied – so a ratio of 2:1 
means for every 2 decibels over the set threshold, only 1 decibel in increase will 
happen. 
Select the whole track and choose Effects menu, Compression. Compress the 
whole signal on the lowest ratio as shown below. The Threshold setting means the 
whole signal will be compressed. The ratio of compression is at its gentlest and 
the attack time is at its fastest which means the beginning of the signal will be 
compressed too. 

 

Figure 26: The compression window using the mildest compression 
on the whole signal 
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8.2 Equalisation 
Equalisation (or EQ) is a tool that allows you to boost the volume of selected 
frequencies whilst all others are left unaffected. You can cut the volume of 
frequencies as well as boosting them, and cutting often sounds more natural than 
boosting. 
Select the whole track and choose Effects menu, EQ. Set the EQ to a smile curve 
as shown. Shelve off unwanted top and bottom signal – look for voices at 
around100hz – 1 Khz and experiment putting the curve there. 

 

Figure 27: The EQ window 
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9 Noise removal 

 

Figure 28: The Noise removal dialogue 

You can remove background noise with the noise removal tool. Select some audio 
from the track that doesn’t have the signal you want (spoken word etc.) but has 
some background noise. Under the effects menu select the Noise Removal tool 
and click on the Get Noise Profile button. The go back to the main screen and 
select the whole track and re-open the noise removal tool if necessary. Click on 
the Remove noise button and audition the result. Choose edit, undo if the noise 
isn’t successfully removed and experiment with the Less/More slider in the tool 
to achieve a better result. Starting with less is a good idea. 
The Noise Removal tool can produce some invasive results if the frequencies you 
want to get rid of are to be found in the spoken word you wish to keep. The tool 
works by scanning the piece of audio you refer it too (the piece with just the 
background noise on) and it makes a frequency profile from this. When you select 
the whole track to be treated, the tool then applies a revers of the frequency graph 
it mapped previously to the whole file. So it takes these frequencies out of the 
whole signal. If these frequencies are in the source you want to keep, that source 
will be effected too. In many instances you will have to make a compromise 
between reducing unwanted noise and keeping an authentic voice that you need. 
Here, it is good to remember that our job in editing is not to aim for perfection 
but to improve what we have iff possible. 
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10 Export/Saving 
You can save your work as an Audacity project (*.aup file) that can re-opened and 
edited as many times as you wish, or you can export the audio to file as a wav, 
mp3 or ogg file. The most common export for podcasting will be to mp3 which is 
a compressed file format that keeps quality acceptable whilst reducing the file size 
so it can be accessed easily from the web. 

 

Figure 29: The save as options from the file menu 

Choose file menu, Export As, .wav (best quality), .mp3 or .ogg 
Wave files (.wav) take up a lot of space but are not compressed. They retain the 
original projects quality and are the best choice for archiving material for re-
deployment in the future. The Mp3 file is a good compromise. The compression 
rate can be set from very low (64 kbps) to good quality (320 kbps). .Ogg is 
another compressed audio file format. 
If you Export As an Mp3, you will have the option of adding tags which will then 
appear in some Mp3 players displays. It is always worth filing these details in 
even though they are couched in musical terms. You can add useful information 
here that documents the file’s properties. Change the genre to alternative or 
other. 
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Figure 30: The ID3 tag options for labelling an Mp3 
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11 Hardware recommendations: 

11.1 Microphone 
 

The easiest way to get a good quality audio signal into your computer (and 
Audacity) is with a USB microphone. A popular and good quality solution for 
podcasting would be the  Samson C01U or C03U (advice true in November 2011). 
http://www.dv247.com/microphones/samson-co1u-usb-condenser-microphone-
-29724 
 

 

Figure 31: Samson's USB mic is ubiquitous and good value 

11.2 Monitors 
There is a huge range of choice on monitors for your computer and the only real 
advice that can be given across the board is not to use the tiny speakers that most 
computers can with – especially laptop speakers - that simply cannot accurately 
reflect the range of audible material that can be recorded. 
If the budget is a real consideration then products such as the Tascam VL-M3 
Powered Monitors will  make a real improvement for not much money. 
http://www.dv247.com/studio-equipment/tascam-vl-m3-powered-monitors--
70093 
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Figure 32: Relatively cheap but much better than computer system 
speakers 

11.3 Headphones 
Editing solely on headphones is not a great idea as what you hear is so specificly 
placed in the stereo image as you have one speaker up against each ear. I you are 
going to use headphones select a fulle enclosure pair and at least a good HiFi 
standard. The Sony MDR-XD200 would be a good starting point. If your budget 
stretches a little deeper, then the industry standard choice is the Beyerdynamic 
DT 150 Dynamic Studio Headphones 

 

Figure 33: Good quality budget headphones with comfortable ear 
pads 
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Figure 34: These Beyerdynamics are expensive but are the industry 
standard 

http://www.dv247.com/headphones/sony-mdr-xd200--65158 
http://www.dv247.com/headphones/beyerdynamic-dt-150-dynamic-studio-
headphones-with-cable-250-ohm--5021 

 


